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Abstrak

Salah satu upaya meningkatkan kesejahteraan masyarakat dan daya saing bangsa adalah dengan mewujudkan pengadaan barang dan jasa yang
menghasilkan value for money. Untuk mencapai hal tersebut maka diperlukan tahapan proses pengadaan barang dan jasa guna mewujudkan
transparansi dan akuntabilitas dengan pendekatan mitigasi risiko. Namun, berbagai risiko dapat muncul dalam setiap tahapan proses pengadaan
barang dan jasa, yang berpotensi menghambat kelancaran pengadaan barang dan jasa. Penelitian ini bertujuan untuk merancang ulang tahapan
proses pengadaan barang dan jasa dengan pendekatan mitigasi risiko, guna meningkatkan efisiensi, efektivitas, dan meminimalkan potensi
lainnya. Metode penelitian yang digunakan adalah pendekatan kualitatif melalui wawancara mendalam dengan pihak-pihak terkait, observasi
langsung, dan analisis dokumen. Identifikasi risiko dilakukan dengan pemangku kepentingan, serta analisis dokumen terkait yang dilanjutkan
dengan perancangan ulang tahapan proses pengadaan barang dan jasa dengan pendekatan mitigasi risiko. Dengan perancangan ulang ini,
diharapkan pelaku pengadaan dapat mengoptimalkan proses pengadaan barang dan jasa serta mengurangi potensi risiko. Hasil penelitian
menunjukkan bahwa terdapat beberapa risiko signifikan dalam proses pengadaan barang dan jasa selama ini, Perancangan ulang tahapan proses
pengadaan dengan pendekatan mitigasi risiko berhasil mengidentifikasi dan meminimalkan risiko-risiko tersebut. Implementasi perancangan
ulang ini diharapkan dapat meningkatkan efisiensi dan efektivitas proses pengadaan, serta mengurangi risiko bagi pelaku pengadaaan. Penelitian
ini juga memberikan rekomendasi strategis bagi organisasi dalam menyusun kebijakan pengadaan yang lebih adaptif dan responsif terhadap
risiko.

Kata Kunci: Procurement of goods and services, Risk mitigation; Process redesign,; Transparency and accountability

Abstract

One of the efforts to improve public welfare and national competitiveness is to realize the procurement of goods and services that produce value

for money. To achieve this, stages of the procurement process of goods and services are needed to realize transparency and accountability with
a risk mitigation approach. However, various risks can arise at each stage of the procurement process of goods and services, which have the
potential to hinder the smooth procurement of goods and services. This study aims to redesign the stages of the procurement process of goods
and services with a risk mitigation approach, in order to increase efficiency, effectiveness, and minimize other potentials. The research method
used is a qualitative approach through in-depth interviews with related parties, direct observation, and document analysis. Risk identification
is carried out with stakeholders, as well as analysis of related documents which is continued with the redesign of the stages of the procurement
process of goods and services with a risk mitigation approach. With this redesign, it is hoped that procurement actors can optimize the
procurement process of goods and services and reduce potential risks. The results of the study indicate that there are several significant risks
in the procurement process of goods and services so far. The redesign of the stages of the procurement process with a risk mitigation approach
has succeeded in identifying and minimizing these risks. The implementation of this redesign is expected to improve the efficiency and
effectiveness of the procurement process, as well as reduce risks for procurement actors. This study also provides strategic recommendations
for organizations in developing procurement policies that are more adaptive and responsive to risk.

Keywords: Procurement of goods and services; Risk mitigation, Process redesign; Transparency and accountability

1. Introduction

In many developing countries, including Indonesia, public procurement represents a major portion of government
expenditure and serves as a primary mechanism for delivering public goods and services. However, the procurement process is
frequently marred by inefficiencies, irregularities, and high susceptibility to corruption. According to the Indonesia Corruption
Watch (2023), there were 791 recorded corruption cases related to public procurement in a single year, underscoring the urgent
need for reform. In response, the Indonesian government has issued a series of regulatory measures—such as Presidential
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Regulations No. 16 of 2018 and No. 12 of 2021—to ensure greater transparency and accountability in public procurement.

Despite these efforts, several challenges remain, especially at the sub-national level. Issues such as vague planning,
inadequate risk assessment, and limited institutional capacity often hamper effective procurement. Moreover, although the
adoption of Electronic Procurement Services (LPSE) has significantly reduced face-to-face interactions and the potential for
collusion, implementation has been inconsistent, and key risk areas remain unaddressed. This necessitates a comprehensive
redesign of procurement stages to systematically integrate risk mitigation strategies, moving beyond mere procedural adherence
to proactive risk management throughout the entire procurement lifecycle (Tsoulfas, 2025).

Public procurement reform is increasingly being understood through the lens of risk governance—the systematic
identification, evaluation, and management of risks that may threaten the integrity, efficiency, or performance of procurement
systems (OECD, 2023; The World Bank Group, 2014). Recent studies emphasize that traditional compliance-based procurement
frameworks are insufficient in addressing dynamic risks such as fraud, contractual non-performance, and information asymmetry
(Adjorlolo et al., 2025; Harju et al., 2024). Effective risk mitigation therefore requires a process redesign that embeds proactive
risk management principles within each procurement stage, from planning and supplier selection to contract execution and post-
award monitoring. The ISO 31000:2018 framework further supports this paradigm, advocating for risk integration within
institutional governance structures to achieve accountability and sustainability (Imane et al., 2023). Specifically, this standard
outlines principles and guidelines for managing risks that can be adapted to the nuanced context of public procurement, ensuring
that risk management is an integral part of decision-making rather than an afterthought. Moreover, a holistic accountability
framework, encompassing internal controls, robust procurement systems, and stringent risk and records management, is crucial
for fostering an ethical, efficient, and transparent procurement environment (Holtzhausen, 2022). An all-inclusive approach to
risk mitigation and corruption prevention across the entire public procurement process is essential to maintain integrity, ensuring
ethical norms such as honesty, professionalism, and righteousness are upheld (Malan, 2021).

International experiences also illustrate that countries which adopt risk-informed procurement models achieve higher levels
of transparency and performance. For instance, a recent study by the World Bank highlighted that countries utilizing robust risk
assessment frameworks in their procurement processes reported fewer instances of corruption and greater public trust
(Dimancesco, 2020). This global trend underscores the necessity of moving beyond rudimentary compliance toward a
sophisticated, integrated risk management strategy in public procurement (Sarto, 2024). In this context, frameworks such as the
European Union’s Directive 2014/24/EU and the United Nations’ Model Law on Public Procurement (UNCITRAL), have inspired
hybrid procurement models that integrate digitalization, stakeholder engagement, and continuous risk monitored (UNCITRAL,
2011). In expending framework, however, the implementation of these models often encounters structural constraints—Ilimited
digital infrastructure, inadequate human capacity, and fragmented risk literacy among procurement officials. Building on this
backdrop, the study addresses the research question of how Indonesia’s public procurement stages can be systematically
redesigned to embed risk mitigation while improving efficiency, transparency, and accountability. In doing so, it develops a
qualitative framework that bridges institutional realities with global best-practice standards.

2. Literature Review

Risk in public procurement arises across all stages—from planning and provider selection to contract implementation and
final delivery. An emphasize that risk management should be integrated into institutional governance, with clear frameworks for
risk identification, analysis, and response (AS/NZS ISO 31000, 2009). The literature identifies various types of risks, such as
technical risks due to inaccurate specifications, financial risks arising from flawed cost estimation, administrative and legal risks
due to non-compliance, and corruption risks due to abuse of discretion or collusion between officials and suppliers.

Multiple models have been proposed for integrating risk mitigation in procurement. The Supply Positioning Model (SPM)
and the Kraljic Matrix help classify procurement needs and guide appropriate risk-handling strategies (Kraljic, 1983).
Additionally, the integration of electronic systems has shown promise in increasing transparency, but without adequate stakeholder
capacity and risk literacy, these tools often fail to deliver their full potential. Previous studies have largely focused on quantitative
modeling (e.g., House of Risk, ANP, ISM), while few have explored qualitative approaches embedded in institutional contexts.
This study endeavors to fill this gap by proposing a qualitative risk mitigation framework tailored for redesigning public
procurement stages in Indonesia, acknowledging both the institutional realities and international best practices (Arrang, 2024).
This qualitative approach seeks to bridge the gap between theoretical risk management frameworks and the practical
implementation challenges faced by public procurement entities in developing nations (Adi, 2020; Kussumardianadewi, 2024).
Moreover, an effective project management office can significantly enhance procurement outcomes by providing continuous
support, clear directions, and robust leadership throughout the tendering and decision-making processes, thereby mitigating
various project-related risks (Ershadi, 2021).

Effective risk management within the procurement process thus necessitates a multi-faceted approach, encompassing
identification, assessment, and the strategic formulation of mitigation actions to preclude negative impacts or reduce their severity
(Kussumardianadewi, 2024; Popa, 2010). This holistic approach ensures that potential risks are addressed proactively, thereby
safeguarding the integrity and efficiency of the procurement lifecycle. This systematic approach aims to minimize risk events that
could affect key procurement project objectives by developing preventive measures and adapting to unforeseen risk factors
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(Kartavyh, 2019). Although various models exist for supply chain and project risk management, their direct applicability to the
complex and often politicized context of public procurement, particularly in developing nations, remains underexplored
(Amrullah, 2021; Putriani Pandiangan, 2016). Specifically, while multi-project Project Management Offices are recognized for
systematically analyzing and managing construction risks, their role in mitigating risks across all stages of public procurement for
goods and services has not been comprehensively addressed (Ershadi, 2021). Furthermore, existing literature often overlooks the
nuances of integrating qualitative risk assessment methodologies within rigid public procurement frameworks, necessitating a
deeper examination of how such frameworks can be adapted for real-world application (Zakaria, 2022). This study addresses this
gap by proposing a qualitative risk mitigation framework specifically designed for redesigning public procurement stages in
Indonesia, acknowledging both institutional realities and international best practices, thereby providing a more holistic
understanding of the PMO's role and impact (Umasekar, 2024). Such a framework will provide practitioners with actionable
strategies to enhance procurement resilience, technological integration, and sustainability within global retail ecosystems, thereby
strengthening compliance and fostering shared risk responsibility among stakeholders (Chowdhury, 2025). To effectively manage
these risks, procurement professionals must possess the necessary skills and knowledge to identify, assess, and mitigate risks
(Perovi¢, 2024). Procurement stages should be investigate to present a better risk mitigation approach. This calls for a
comprehensive re-evaluation of current procurement methodologies to embed robust risk management practices directly into the
workflow, rather than treating them as an ancillary concern. A study highlights the importance of transparency, professional
standards, SME support, and digital transformation in procurement. It identifies risks throughout the procurement cycle, proposing
targeted mitigation. The study also emphasizes the national public procurement plan's role in simplifying procedures, reducing
barriers, promoting fair competition and cost efficiency (Tsoulfas, 2025) and also made an early warning models to prevent
malpractice in public procurement (Martinez, 2020).

3. Methods

This study adopted a qualitative research design, with a case study approach centered on the Procurement Bureau of the
North Sumatra Provincial Government. A qualitative methodology was chosen to gain an in-depth understanding of the
institutional dynamics, human factors, and decision-making processes involved in procurement. Data were collected through semi-
structured interviews with certified procurement officers, including Pejabat Pembuat Komitmen (PPK), Pokja ULP, and LPSE
administrators. Participants were chosen purposefully to capture diverse yet information-rich cases relevant to the research
objective (Creswell, 2018). The selection emphasized expertise and variation in experience, ensuring that data saturation was
achieved through depth. This approach allowed the research to generate contextually grounded and theoretically meaningful
insights into risk mitigation practices within Indonesia’s public procurement system.

The participants in this study consisted of seven certified procurement officers from the Procurement Bureau of the North
Sumatra Provincial Government (Biro Pengadaan Barang dan Jasa Setdaprovsu). They were selected purposively based on their
certification levels (Procurement Specialist Levels I-III) and their extensive professional experience ranging from 8 to 20 years
in managing different stages of the public procurement process, which are planning, supplier selection, and contract
implementation. Each participant holds an official certification issued by the National Public Procurement Agency (LKPP),
ensuring that they possess the technical competence and institutional knowledge required to provide informed insights into
procurement practices. Their positions included Pejabat Pembuat Komitmen (PPK), Kelompok Kerja (Pokja), and functional
procurement officers (4hli Pertama—Madya), enabling a multi-perspective understanding of both operational and strategic
procurement risks. Additional data sources included procurement documents, government regulations, and direct observations of
procurement procedures conducted through the LPSE system. Thematic analysis was employed to process the data. Key themes
related to procurement risks, institutional weaknesses, and opportunities for process improvement were identified through coding
and cross-case comparison. To ensure validity, data triangulation was conducted by comparing information from interviews,
documents, and observations.

4. Result and Discussions

4.1. Procurement Planning Stage: Risk Identification and Mitigation

The procurement planning stage emerged as the most critical phase influencing the efficiency and integrity of subsequent
procurement activities. Consistent with ISO 31000 principles, this stage determines how well risks are identified, analyzed, and
treated before they escalate into contractual or performance failures. Across all interviews, respondents emphasized that planning
serves as the “foundation of procurement governance”, where early misjudgments in needs assessment, technical specifications,
or budgeting inevitably propagate to later stages.
Thematic analysis of the interviews revealed six dominant risk clusters:
(1) inaccurate needs identification,
(2) improper work packaging,
(3) mis-specified technical requirements,
(4) weak market analysis,
(5) unrealistic scheduling and budgeting, and
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(6) administrative errors in the procurement plan (RUP).
Each category aligns with one or more stages in the ISO 31000 risk cycle—particularly risk identification, analysis, and
treatment—and represents systemic weaknesses within institutional coordination and human-resource capacity.

4.2. Procurement Planning Stage: Needs Identification

Nearly all informants agreed that inaccurate or incomplete needs identification is the roof cause of procurement inefficiency.
One senior procurement officer noted, “The initial information from user units is often inaccurate or not aligned with program
priorities... as a result, some items become redundant or underused.” This pattern suggests that needs assessments remain largely
reactive and lack participatory validation.

The data indicate that insufficient cross-unit consultation and the absence of structured risk reviews lead to procurement
items that are inconsistent with institutional objectives. Such findings resonate with OECD (2023) observations that poor upstream
planning increases the likelihood of “wrong-product” procurement and wasteful expenditure.

Mitigation therefore requires early inter-unit coordination, historical-data analysis, and stakeholder involvement—
particularly end-users and technical experts—to validate relevance and scale. Embedding a risk-register template at this stage
would institutionalize early detection and prioritization of planning errors.

4.3. Procurement Planning Stage: Work Packaging

Risks in packaging (or “pemaketan”) arise when contracts are either over-aggregated or excessively fragmented.
Respondents highlighted that oversized packages tend to exclude small- and medium-scale suppliers, while over-segmentation
complicates coordination and quality control. As one informant explained, “When packages are too large, SMEs cannot
participate; when too small, we end up with many contractors and inconsistent quality”. This finding reflects a trade-off frequently
cited in the procurement literature between economies of scale and competitive diversity. Improper packaging undermines fair
competition and transparency—two fundamental pillars of good procurement governance.

Mitigation measures include conducting market-capacity analyses prior to packaging decisions and instituting a pre-RUP
review by the Procurement Service Unit (UKPBJ) to verify proportionality and compliance with fair-competition standards. This
internal validation serves as the “risk-treatment” phase within ISO 31000, ensuring that structural market risks are identified
before tender announcement.

4.4. Procurement Planning Stage: Technical Specifications

Deficiencies in technical specification (and the Terms of Reference) were the second-most cited risk after needs
identification. Informants frequently described specifications that were “too generic to evaluate objectively” or “too restrictive,
indirectly pointing to a specific brand.” Such inconsistencies create ambiguity in evaluation and expose the process to legal
contestation.

The evidence reveals that limited technical expertise among drafting officials often results in copy-pasted documents from
prior projects, disconnected from field conditions. This leads to frequent contract addenda and re-scoping during execution.

Risk mitigation strategies, according to multiple respondents, include involving subject-matter experts, conducting market
and technology scans to confirm specification feasibility, and introducing peer review or internal quality control before tendering.
These measures correspond to the “risk-analysis™ and “risk-treatment” steps in ISO 31000, strengthening accuracy and compliance
while preserving competitive neutrality.

4.5. Procurement Planning Stage: Market Analysis and Method Selection

Market analysis remains an underdeveloped component of procurement planning. Respondents acknowledged that outdated or
incomplete market data frequently distort cost estimation and selection of procurement methods. One official observed, “Using
last year’s prices or unverified supplier data often leads to choosing the wrong method—sometimes we tender when only a few
suppliers exist, or do direct selection when the market is competitive.”

This insight underscores a systemic weakness in data governance rather than mere procedural error. The lack of real-time
market intelligence results in mismatches between planned methods and actual supplier capacity, a phenomenon similarly
identified in World Bank (2016) benchmarking.

To mitigate, the study proposes institutionalizing periodic market surveys, integrating price-index databases into e-
procurement platforms, and mandating documentation of market-analysis reports as auditable evidence. These practices enhance
transparency and accountability while enabling adaptive method selection.

4.6. Procurement Planning Stage: Scheduling and Budgeting (HPS)

The scheduling sub-stage was found to suffer from overly optimistic timelines and disconnection from fiscal cycles.
Informants admitted that unrealistic planning often stems from pressure to accelerate disbursement rather than empirical duration
data. Consequently, procurement delays and under-absorption of budgets recur annually.

Similarly, inaccurate cost estimation, especially in determining the Harga Perkiraan Sendiri (HPS)—creates downstream
problems such as bid cancellations or cost overruns. As one participant stated, “Technical teams often finalize specifications
before confirming budget ceilings, so later they must reduce volumes or revise scope.” This reflects weak integration between
planning and budgeting functions.
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Mitigation involves synchronizing procurement schedules with the annual work-plan (RKA), conducting cross-checks
between planning and finance divisions, and employing historical cost data and current market indexes for HPS validation. This
aligns with ISO 31000’s emphasis on risk monitoring and control mechanisms across inter-departmental interfaces.

4.7. Procurement Planning Stage: Procurement Plan (RUP) Administration

The final sub-stage, preparation of the Rencana Umum Pengadaan (RUP), carries administrative and compliance risks.
Common issues include delayed publication, incomplete entries, and misalignment with approved budgets or methods. Several
informants cautioned that late or inaccurate RUP inputs can halt subsequent tenders and trigger audit findings.

Mitigation requires introducing a multi-layer verification process prior to RUP finalization, involving planners, finance
officers, and UKPBJ staff. Staged data entry and periodic updates can transform the RUP from a static requirement into a “/iving
document” reflecting real-time adjustments—thus fulfilling ISO 31000’s continuous improvement principle.

4.8. Procurement Planning Stage: Cross-Cutting Insight

Across all sub-stages, the analysis reveals that risk persistence is not primarily regulatory but institutional and behavioral
rooted in inadequate coordination, limited competence, and weak internal control. The pattern confirms Pressman and Wildavsky’s
implementation theory: policy failure often results from fragmented inter-actor communication rather than policy design itself.

Accordingly, the planning stage should not be viewed merely as a technical formality but as a risk-governance process
requiring joint accountability among PPK, KPA, UKPBJ, and supervisory units. The integration of structured risk registers,
collaborative validation, and data-driven planning mechanisms is therefore imperative to shift from reactive correction to proactive
prevention.

4.9. Supplier Selection Stage: Risk Exposure and Governance Response

The supplier selection stage represents a crucial point of vulnerability where procedural fairness, transparency, and
accountability are tested. Although Indonesia’s procurement framework (Perpres No. 16/2018; No. 12/2021) is well-defined,
interviews revealed that implementation remains prone to inconsistent interpretation, subjective evaluation, weak qualification
checks, and poor documentation. These issues correspond to the risk evaluation and treatment phases of ISO 31000 and highlight
institutional rather than regulatory weaknesses.

Table 1. Key Risk and Mitigation Strategies in Supplier Selection Stage

Risk Category Key Findings Evidence from Interviews) Proposed Mitigation ISO 31000 linkage

Regulatory
Interpretation
&Procedural
Inconsistency

Bias & Evaluator
Discretion

Verification of
Supplier
Qualifications

Documentation &
Audit-Trail
Weaknesses

Cross-Cutting
Institutional Insight

Different evaluators interpreted
clauses inconsistently,
particularly in post-
qualification, leading to uneven
shortlisting  and  excessive
clarifications.

Despite LPSE wuse, scoring
remains subjective; “technical
proposal scores depend on
perception,” creating bias and
conflict-of-interest risks.

Uploaded  credentials  are
seldom cross-checked;
unverified tax, financial, or
certification data enable
unqualified bidders.

Evaluation notes and
clarification  records  often
incomplete, limiting traceability
during audits.

Persistent ~ behavioral  and
capacity gaps show that digital
tools alone cannot ensure
transparency.

Conduct periodic  alignment
workshops, develop standardized
evaluation checklists, and
strengthen UKPBJ oversight.

Establish multi-layer evaluation
teams, rotate evaluators,
implement digital audit trails and
integrity-pact acknowledgments
within LPSE.

Integrate LPSE with national tax
and certification databases; apply
risk-based verification for high-
value tenders.

Enforce mandatory e-
documentation upload before
contract award; schedule

periodic internal audits of LPSE
records.

Combine ethics reinforcement,
evaluator training, and
accountability frameworks
among  Pokja, PPK, and
oversight agencies.

Risk Communication &
Consultation — ensuring
shared  interpretation
before evaluation.

Risk  Treatment &
Control — minimizing
human bias through
structural safeguards.

Risk Prioritization —
focusing due-diligence
resources on  high-
exposure tenders.

Monitoring & Review —
ensuring  continuous
compliance and
traceability.

Risk  Governance &
Continuous
Improvement -
integrating human and
system-level
adaptation.
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4.10. Supplier Selection Stage: Risk Exposure and Governance Response

The supplier selection stage is the most sensitive phase of the procurement process, where compliance, transparency, and
fairness are directly tested. Although Indonesia’s regulatory framework (Presidential Regulations No. 16 of 2018 and No. 12 of
2021) provides detailed procedural guidance, interviews with the seven certified procurement officers revealed that
implementation remains inconsistent and vulnerable to discretion, weak verification, and documentation lapses. These issues
illustrate that risk exposure at this stage stems more from institutional behavior and capacity gaps than from deficiencies in
regulation. Table 4.2 summarizes the key risk themes, supporting evidence, proposed mitigation strategies, and their alignment
with the ISO 31000 risk-governance principles.

Table 2. Key Risks and Mitigation Strategies in the Supplier Selection Stage

805

Risk Category  Key Findings (Evidence from Interviews) Proposed Mitigation ISO 31000 Linkage
. Evaluators interpret clauses . . . . S
Regulatory R ° apret v Standardize evaluation checklists o Risk  Communication &
. differently—especially during post- . . .
Interpretation & . d . . h and conduct regular alignment Consultation — build shared
qualification—causing inconsistent .
Procedural . . workshops under UKPBJ understanding before
. bidder assessments and excessive e .
Inconsistency . . supervision. evaluation.
clarifications.
. rin; f Rotate evaluator: mploy multi- .
. Despllte LPSE use, ~scoring © otate evatuators, employ mu . Risk Treatment & Control —
Bias & Evaluator technical proposals remains layer evaluation teams, and record .
. . . . . . . . reduce human bias through
Discretion subjective; evaluators admit reliance all scoring changes via LPSE digital
. . procedural safeguards.
on personal judgment. audit trails.
. . . . . Integrate LPSE with tax an . TN
Verification of e Uploaded financial or certification cgrate. S . d . Risk  Prioritization — —
. . . certification databases; apply risk- o
Supplier data rarely verified; unqualified . . . allocate due-diligence effort
. . . . based verification for high-value .
Qualifications suppliers can pass screening. tenders to high-exposure tenders.
. . Enforce mandatory e- L .
Documentation & o Incomplete evaluation notes and . . Monitoring & Review -
. . . ; . . documentation  before  contract L .
Audit-Trail clarification records hinder post-audit T maintain traceability and
. award and conduct periodic internal . .
Weaknesses accountability. continuous compliance.

Cross-Cutting

Institutional Insight

. Behavioral and capacity gaps persist;
technology alone cannot ensure
transparency.

audits of LPSE files.

Reinforce ethics, training, and
accountability frameworks among
Pokja, PPK, and oversight agencies.

Continuous Improvement &
Risk Governance — integrate
human and system
adaptation.

4.11. Contract Implementation Stage: Operational Risks and Mitigation Practices

The contract implementation stage is where procurement outputs translate into tangible results, yet it also presents the highest
operational risk exposure. Interviews with the seven certified procurement officers revealed that, even after a transparent selection
phase, challenges persist during contract execution—particularly delays, deviations from specifications, and weak monitoring.
Most of these issues originate from limited supervision capacity, poor communication between PPK and providers, and
inconsistent application of sanctions. Such weaknesses highlight the need to strengthen the monitoring, control, and review
dimensions of the ISO 31000 framework. Table 4.3 outlines the key risk themes, representative evidence, and recommended
mitigation actions to enhance accountability and performance during contract execution.

Table 3. Key Risks and Mitigation Strategies in the Contract Implementation Stage

Risk Category Key Findings (Evidence from Interviews) Proposed Mitigation ISO 31000 Linkage
. . Delays occur c}ue to unreallstlcltlmgllnes, . Req‘ulr-e early mf)blllzatlon meetings, | Risk Treatment & Monitoring
Project Delays & weather disruptions, and late mobilization of realistic scheduling based on risk ..
. . « — anticipate and respond to
Scheduling Slippage contractors. Officers noted “work often starts assessment, and enforce penalty clauses .
. " . schedule deviations.
before complete readiness. for unjustified delays.
Deviation from Contractors sometimes substitute materials o Implement digital progress-reporting e Risk  Control —  ensure
Technical or methods not matching specifications, tools (photo documentation / geo- compliance through
Specifications especially in remote projects where tagging) and independent technical verification and
P supervision is limited. inspections. documentation.
inati t PPK. . .. I . L
Weak Contract © Coordination 8aps between ., e Conduct  routine  joint-monitoring e Risk Communication -
.. consultants, and contractors reduce oversight . RO o
Supervision & . « S . meetings; define clear communication strengthen coordination to
S effectiveness. “Reporting is often reactive, . . . .
Communication protocols and escalation mechanisms. prevent failure escalation.

Payment & Financial
Administration Risk

not preventive.”

Late verification of work completion leads to
delayed payments or premature
disbursement.

Align progress payments with verified
milestones and integrate e-verification

within LPSE financial modules.

. Risk Evaluation — validate
deliverables before financial
commitment.
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Risk Category Key Findings (Evidence from Interviews) Proposed Mitigation ISO 31000 Linkage
Dispute & Sanction ° Contract disputes arise from ambiguous e Standardize contract templates with e Risk Governance — clarify
Mall;)a ement clauses and inconsistent sanction clear dispute-resolution pathways and accountability to ensure fair

& enforcement. consistent sanction application. enforcement.

. Most risks stem from weak monitoring . o .
. . Develop integrated monitoring e Continuous Improvement —
Cross-Cutting culture rather than regulatory gaps. . g S . .

" . . .. . dashboards and continuous training for institutionalize learning from

Institutional Insight Strengthening supervision capacity and data- . . .

PPK and supervisory teams. implementation outcomes.

driven evaluation is critical.

5. Conclusion

This study provides a comprehensive redesign of public procurement processes using a risk mitigation approach tailored to
the provincial government context. By applying a qualitative lens, the research uncovers institutional and operational
vulnerabilities that often escape quantitative analysis. The proposed five-feature redesign and its implementation framework aligns
digital innovation, accountability mechanisms, and adaptive monitoring to be proactive risk management strategies that can
significantly improve procurement efficiency, reduce irregularities, and strengthen public trust. By embedding structured risk
identification, digital validation tools, continuous training, whistleblower integration, and post-contract monitoring, the redesigned
process aligns risk management with the operational realities of local governments. The resulting framework clarifies roles,
mechanisms, and priorities, providing a roadmap for gradual institutionalization of risk-aware procurement practices. The
redesigned model offers a practical and scalable pathway toward transparent and accountable procurement governance at the sub-
national level.

Future research is recommended to validate this five-feature model across other local governments and to explore hybrid
designs combining qualitative insights with quantitative tools for procurement risk scoring tools that support evidence-based
procurement reform and sustainable public-sector governance.
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Instructions to Authors for Word template

1. Locking of Copyright:

The copyright line is locked in the LWSA Conference Series templates. The author may not edit the same and making it editable
only PSMs. If there are any copyright changes required, you are requested to contact Journal Manager through Guest Editors. For
editable the below mentioned steps must be followed:

Steps:
» Click on copyright statement
» Click on Properties in Developer tab
» Remove the checks from Content control cannot be deleted and Contents cannot be edited under Locking and then
Press ok

2. Docm format:

We have added macros in the Word templates for the below mentioned features. And since macros are not supported in doc
and docx format we created the templates of all LWSA Conference Series titles in .docm format.

» Removal of all highlights
»  Accept track change
» Locking of Rules

If .docm format needs to convert in docx format then the following steps must be performed:

Steps:
» Press Alt F11
» Click on Project (JID_Template)
» Enter "thomson" in Project Password
» Click on Microsoft Word Objects
» Click on ThisDocument under Microsoft Word Objects
» Delete all macros under General
» After deletion close the Code and Project (JID_Template) windows
» From File menu click on save as type .docx option

3. Comments added in the margin in Word master templates:

There are instances where author raising queries on what to do with key information lines such as “volume, page numbers”,
“Conference title per issue” and “Copyright entity, year, copyright TALENTA Publisher Universitas Sumatera Utara. and
Organizer Name” in the copyright statement and for these concerns the comments have been inserted in the Word template to
guide Author/JM about the information to be inserted by them in these fields.

Comments removal from Print: In Word 2007 and 2010 the comments present in a document get printed by default. If the
authors do not want to get the comments appearing in print, the authors must remove the comments from the Word template before
printing by changing the Print markup setting of word using the following steps:

Steps:
» Click the File tab
» Click Print
» Under Settings, click the arrow next to Print All Pages
» Click Print Markup to clear the check mark
Instructions to Authors pages to be excluded from Print:
» Click the File tab
» Click Print
» Under Setting, Type page numbers and/or page ranges separated by commas counting from the start of the document or
the section. For example, type 1, 3, 1-5

4. PDF creation from Word master template:
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While creating PDF from Word template the below given steps should be followed to avoid difference in trim size and margins
and to avoid decrease in resolution and size of the figure images of the Word template and the PDF created.

Steps in Word 2007 and 2010:

>
>
>
>
>
>
>

VVYVYVVYY

>
>

Click the File tab

Click Print

Under Printer tab, select Adobe PDF

Click Printer Properties link

Under Adobe PDF Settings tab, click on Edit button

Click on Images folder under Standard

Make Downsample and Compression fields under Color Images and Grayscale Images "Off". And in Monochrome
Images field make only Downsample "Off'

Then click on OK and given name of the setting in File name tab and click on save

Then again Under Adobe PDF Settings tab, click on Edit button

Then click on Color folder

Choose Leave Color Unchanged option under Color Management Policies tab then click on OK
Lastly click on OK in Adobe PDF Settings tab

Click Save As

Under Save as type, click the arrow next to PDF (*.pdf)

Click Save

In Word 2003 the PDF can be created by using “Convert to Adobe PDF”” symbol in tool bar or the required paper size can be
adjusted in the Adobe PDF settings given in the Properties tab on the Print option. Please follow the above steps to avoid decrease
in resolution and size of the figure images.

5. Reference style used in LWSA Conference Series:

Title

Reference style

LWSA Conference Series APA Style

6. Content Paper:

This conference paper has four subchapters consisting of introduction, research methods, results and discussion, and
conclusion, as well as acknowledgments (optional) and references. The submitted paper uses English.



